Informatique Médicale & Biostatistique

0 trouvez l'option This PC et creer sur le bureau de 'ordinateur un nouveau dossier

nome TPO4NP par 'option New—Folder (voir I'image suivante)

Folder
#| Shortcut

View
Sort by
Group by
Refresh

> i] Microsoft Access Database
5 @ Bitmap image

> [#=] Contact

ﬂ%_] Microsoft Word Document

Customize this folder...

Hi-l] Microsoft PowerPoint Presentation

Paste

Paste shortcut

ﬁ_] Microsoft Publisher Document
_ET;’ STATISTICA Spreadsheet
EI Text Document

Give access to

> @ Microsoft Excel Worksheet

New

> g Compressed (zipped) Folder

Properties

|

0 File»Save As—This PC—»Desktop-> dossier TP04NP

0 Clic droit sur le nom implicite de la feuille de calcul (en bas de la feuille de calcul,

vous aurez le nom Sheet 1=Feuillel) + Renommer (Rename)

» Onva ecrire le tableau suivant

Tabagisme

Nombre de cas

Fumeurs (=1)

Non-fumeurs (=0)

» Chercher la fonction COUNTIF dans I'option Formulas->Insert Fonction

D2 k4

xX v

C D E F G H 1 J K
1 [ Tabagisme Freguence absolue
2 0 Fumeur (=1) =
& 1 Non-fumeurs (=0)
4 0
5 0
6 0 Insert Function ? X
7 1
Search for a function:
8 0 _ -
9 0 Type a brief description of what you want to do and then dick Go|
10 1 <
O select a category: | Most Recently Used b

] 0
12 0 Select a function:
13 0
14 0 RAND

STDEV
15 0 MODE
16 0 MEDIAN

AVERAGE
17 0 i %
i 4 COUNTIF(range,criteriz)
i 1 Counts the number of cells within a range that meet the given candtion.
20 0
21 0
22 0
23 0
24 0 Help on this function oK Cancel
25 0
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B C D E | E | G | H | | J | K | L
Tabagisme Frequence absolue
Fumeur (=1) =COUNTIF(A2:A401,A3)
Non-fumeurs (=0)

Function Arguments ? X

COUNTIF

Range | A2:2401 = {0:1;0:0:0;1;0:0;1;0:0;0:0,0;0,0:0;0;0;0:0:0:0;0:0;1;0,0:C

=1

1+ |1

Criteria | A3

= 68

Counts the number of cells within a range that meet the given condition.

Criteria is the condition in the form of a number, expression, or text that defines which cells will be
counted.

Formula result = 68

Help on this function Cancel

olo|loc|ojo|o|o|c|o|o|o|o|r|o|o|r|o|jo|oirio

> Le tableau de frequence va avoir la forme suivante:

C D

Tabagisme Frequence absolue
Fumeur (=1) 68
Non-fumeurs (=0) 332

0 sélectionnez les données du tableau de frequence (les 4 ou plus cellules du votre
tableau sans le titre du tableau) ;

o cherchez le tab: Insert— Pie;

Page Layout Formulas Data Review View @ Tell me what you want to do...

' Dshapes~ 2 = B e | gl
b Sl lgd®™ am BB i SR04

:nded Table | Pictures Online . & My Add-ins - Bing People Recommended .. . of, . PivotChart 3D
Jles Pictures @ Screenshot i Maps Graph Charts " l— A = Map ~
Illustrations Add-ins 2-D Pie ours
3 \ P o
% (ON @ @F
B | 6 l D l E l F l G l

0 choisissez quel type de pie vous voulez et puis cliquez 2 fois sur le graphique pour
activer I'option Design ou vous pouvez choisir le graphique camembert ayant
les pourcentage+le titre+la legende;

Page Layout Formulas Data Review  View Design Format Q Tell me what you want to do...

i erant Tma o

.. 7 ’ =

Chart Styles
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o la forme finale du graphique doit avoir :
le titre : » Distribution des ......... dans I'échantillon étudié”,
les l1égendes

les pourcentages

> DéplaceZe curseur sur une cellule dans la base de données (ex. la cellule A2 de la

%
. L . . PivotTable
feuille COLONNES) et puis choisissez dans I'onglasert — option : Pivot Table - ;
» La fenétreCreate Pivot Table va apparaitre;

> Les données se trouvent dans une feuille de c&ectl donc vous choisissez toutes les
données avec le titre dans le chahaple/Range

£ Search (Alt=Q)

< Pati

File Home Insert Page Layout Formulas Data Review View Help

= | B 7 B % i d 1 - ¢ ? :
...... i K = :
Y_ |'_
Tables lllustrations Add-ins Charts
D1 ¥ Je 3
A B C D | E | F | G | H | | | J | K L
E PivotTable from table or range ? X
i Select a table or range
1| | Table/Range: | Sheet131$AS1:5A5401 3
2 3 Choose where you want the PivotTable to be placed
3 3 4
o Mew Worksheet
4 2
5 3 @ Existing Worksheet .
6 5 Location: Esheet!3!$D$!| _1
7 2 Choose whether you want to analyze multiple tables
8 2 [] Add this data to the Data Model
= : cance
11 2
12 2
13 3
»  Mettez ce rapport dans la méme feuille de calcal gxemple dans la cellule D1 dans
le champExisting Worksheetet cliquez sur le bouton OK (comme est indiquésdamage
antérieure)
> Déplacez (glisser) la variable d'intérét (ex.« Tolae d’Age ») de la fenétre des variables

Pivot Table Field List dans la zone deRbw Labels” pour trouver les catégories de la variable
Déplacez (glisser) LA MEME VARIABLE dans la région ¥alues» pour compter les valeurs

dans chaque catégorie (Voir ci-dessous)
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PivotTable Fields v X
Choose fields to add to report:
Search /O
i Tranche d'age rage<=44 ans; 2=45-54 ans; 3=55-74 ans; 4: age>=7...
ET he d'ag (1:ag 44 2=45-54 3=55-74 4: ag 7
Maore Tables...

Drag fields between areas below:

Filters Columns
Rows 2 Values
Tranche d'age l.ag.. ~ Sum of Tranche d'age ¥

[ ] Defer Layout Update

Vous aurez un tableau, comme dans l'image ci-dessou

D E
Row Labels | ~ |Sum of Tranche d'age (1: age<=44 ans; 2=45-54 ans; 3=55-74 ans; 4: age>=75 ans)
1 47
2 236
3 660
4 60
Grand Total 1003

Note. vérifiez toujours si le total dans le tableau est égal a la taille de I'échantillon !!!
Dans le cas ou vous n'avez pas d'égalité, assurez-vous que la fonction de calcul dans le
tableau croisé dynamique est la fonction COUNT.

> Dans notre exemple, I'Excel a utilisé la fonction SUM et pour changer-la, fait un
clic droit sur la cellule contenant ,Sum of Tranche d’age” et choisir la fonction désirée

COUNT
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Value Field Settings ? X
Source Mame: Tranche d'age (1: age<=44 ans; 2...
Custom Name: | Count of Tranche d'age (1: age«=44 ans; 2=45-54 ans; 3=55-74 ans; 4: age>=75 ans)

Summarize Values By Show Values As

Summarize value field by

Choose the type of calculation that you want to use to summarize
data from the selected field

Product v

Number Format Cancel

> Le tableau de fréquences correctement réalisé est de la forme suivante :

1 D L E

Row Labels ~ |Count of Tranche d'age (1: age<=44 ans; 2=45-54 ans; 3=55-74 ans; 4: age>=75 ans)

1 47
2 118
3 220
4 15
Grand Total 400

> Remplacer les codes numériques par des étiquettes en écrivant les noms désirées

pour les tranches d’age ; le tableau va avoir la forme suivante :

Row Labels - Count of Tranche d'age (1: age<=44 ans; 2=45-54 ans; 3=55-74 ans; 4: age>=75 ans)

<=44 ans a7
45-54 ans 118
|55- .l 220
4 15
Grand Total 400

0 sélectionnez les données du tableau de frequence anterieurement cree (sans le
total) ;

o cherchez le tab: Insert— Colonnes ;
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Home Insert Page Layout Formulas Data Review View Help PivotTable Analyze  Design
F [?) Shapes v 33 SmartArt v v =]
tS 2 = B GetAdd-ins O |:I:|? B @ [ ﬂ'ﬂg@ &~ i
Icons @ Screenshot ~
Pictures 3 e (J . Recommende 2-D Column 3D Line Column
« €D 3D Models ~ SIMy Add-ins > oy Charts Map ~
Tables lllustrations Add-ins ”]1['1 [E_H [ﬂ_ﬂ Tours Sparklines
M Je Row Labels Clustered Column
31 Use this chart type to:
A B C D L . Comptare values across a few
—
inche d'age Use it wih
se it when:
;:_f;:_“ a:" 7554 an?, sl The order of categaries is not
ans; :age>= ans, 1
‘ JRow Labels - Count of Tranche d'age ( important. ns; 4: age>=75 ans)
3 <=44 ans 47
3 45-54 ans 118
2 55-74 ans (o — 0 220
Count of Tranche d! i 3=55-74...
3 =75 ans unt oL Liandie,cage, 3.0 Rar 15
2 Grand Total 400
2
5 250
3
200
1 U][[ More Column Charts...
2 150
(o] o]
2 m Total
3
1
3
3
2
3

100

<=44 ans

Tranche d'age

~

55-74 ans

(1: age<=44 ans; 2=45-54 ans; 3=55-74 ans; 4:... ¥

~

III
0 |

45-54 ans

z75ans

~

» Pour insertion du titre, des fréquences, titres des axes, utiliser 'option DESIGN

Page Layout

File Home  Insert
|E *
Add Char} Quick Change
Element vjLayout ¥ | Colors >
iﬂ; Axes >

b Axis Tities >

[ ChartTitle >
17

S

Formulas Data Review View Help

l]|

"

Chart Styles

PivotChart Analyze

Design

Format

' -I'_.._._lj_; nﬂu_' '.I_I_ .II.

o

E Switch Row/ Select

Column Data

Data

Cha

Data Labels >

Q; Data Table >
fis Error Bars >
Il Gridiines > 3
[hm Legend > =
2
? 3
3 _ 2
=¥ Trendline > >
? 2
<) 3
10 1
11 2
12 2
1= 3
14 1
15 3
16 3
17 2

Row Labels | ~ | Count of Tranche d'age

[1Lage<=44 ans; 2=45-54 ans; 3=55-74 ans; 4: age>=75 ans) L

<=44 ans
45-54 ans
55-74 ans O
275 ans Count of Tranche d'age
Grand Total
250
200
150
Q
100
50
., N
<=44 ans

Po
O

(1: age<=44 ans; 2=45-54 ans; 3=5574...

Total

45-54 ans

55-74 ans

z75ans

m Total
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» On va ajouter au tableau de fréquences absolues, les fréquences relatives

D

E

F

G

Row Labels ~

Count of Tranche d'age
(1: age<=44 ans; 2=45-54 ans; 3=55-
74 ans; 4: age>=75 ans)

Frequnces relatives

Frequnces relatives
cumulees

<=44 ans 47|=47/400
45-54 ans 118
55-74 ans 220
=75 ans 15
Grand Total 400

>

absolue et la taille de I’échantillon

D

E

Les fréquences relatives seront calculées en faisant le rapport entre la fréquences

G

Row Labels | -~

Count of Tranche d'age
(1: age<=44 ans; 2=45-54 ans; 3=55-
74 ans; 4: age>=75 ans)

Fregqunces relatives

Frequnces relatives
cumulees

<=44 ans 47 0.1175

45-54 ans 118 =118_!'4DD|

55-74 ans 220

=75 ans 15

Grand Total 400
> Les fréquences relatives cumulées croissante seront calculées en faisantla somme
des fréquences relatives qui correspond aux tranches d’age inferieures a la classe
desirée

D E F G

Count of Tranche d'age

Frequnces relatives

Fregunces relatives

(1: age<=44 ans; 2=45-54 ans; 3=55- cumulees
Row Labels - |74 ans; 4: age>=75 ans)
<=44 ans 47 0.1175 0.1175
55-74 ans 220 0.55
=75 ans 15 0.0375
Grand Total 400
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» Déplacede curseur sur une cellule dans la base de données (ex. la cellule A2 de la
feuille nomée COLONNE_2_variables) et pi'ic ~hnicigsez dans I'onglasert — option : Pivot

%
PivotTable
Table =
» La fenétreCreate Pivot Table va apparaitre;

» Les données se trouvent dans une feuille de célxcdl donc vous choisissez toutes les
données avec le titre dans le chahaple/Range

File Home Insert Page Layout Formulas Data Review View Help
Tables lllustrations Add-ins Charts Tours
D1 - Ji oui
A B (& D E F | G _H | | | J K | L M N

Hypertension CoviD-19 PivotTable from table or range ? X
2 |oui posi‘[if Select a table or range
il ot BHsitif I Table/Range: |sheet14!$451:58$401 4
4 |non negatif

(s v Choose where you want the PivotTable to be placed
5 |oui positif
6 |oui positif () Mew worksheet
7 |oui positif Existing Worksheet
8 |non negatif Location: | Sheet141$D$1 *
9 |oui positif

T 005e Whether you want to analyze multiple tables
10 |non positif -

T - D Add this data to the Data Model
11 |non negatif
12 |oui positif cancel
13 |oui positif
14 |non negatif
15 |oui positif

»  Mettez ce rapport dans la méme feuille de calcal @xemple dans la cellule D1 dans
le chamExisting Worksheetet cliquez sur le bouton OK (comme est indiquésdamage
antérieure)
> Déplacez (glisser) une des variables d’interéadenétre des variabl®svot Table Field
List dans la zone deRow Labels” (par exemplédypertension) pour trouver les catégories de la
variable Déplacez (glisser) la deuxieme variable (COVIRY)dans laColumns et dans zone

région «Values» pour compter les valeurs dans chaque catégéoie ¢i-dessous)
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PivotTable Fields

Choose fields to add to report:

Search

Hypertension
COVID-19
Mare Tables..

Drag fields between areas below:

T Filters Il Columns

COVID-19 -
= Rows % Values
Hypertension hd Count of COVID-19 hd

* copier le tableau de contingence anterieurement cree (sans les totaux) dasn la meme

page (ou vous voulez) ;

e cherchez le tab: Insert— Barres ;

AutoSave (@ OfF) D~

File Home Page Layout  Formulas Data  Review

ré Shapes ¥

'-'g Icons

B D

23 SmartArt

@i Screenshot v

Patientsxlsx v

£ Search (Alt+Q)

View Help

&

e [Ee- A

B Get Add-ins

PivotTable Recommended Table Pictures . Recommended ~ 2-D Column
~ PivotTables ~ (3 3DModels ~ 62 My Add-ins B Charts
Tables lllustrations Add-ins ”]1[ﬂ [H_H [B_ﬂ
116 - f
3-D Column
A B C D | E F G | H | [
17 |BH positif BH lﬂm J-QH» J—@-@ Jjﬂml
18 |CJ positif BN
19 BN negatif cJ
20 BN positif MM
21 BN positif SM
22 BN negatif g E E
23 BN positif o,
24 BH positif Clustered Bar
25 |Sm negatif ‘ Use this chart type to:
26 CJ negatif - -Comp._are values across a few
27 [sm negatif h g categories.
gl c positif MM F Use it when:
29 |BH negatif |l * The chart shows duration.
30 Q) negatif cl _ « The category text is long.
31 |a positif Q
32 BH negatif BN .
33 positif
34 BH negatif Tl ESNE——
35|Q negatif
N 0 20 40 60 20 100 120
36 |CJ negatif
37 BN positif B COVID-19 positif @ COVID-19 negatif

>

o F gl

7

Line Column '

Map v
Tours Sparklines
K
34
7
67
5
15
— 0
= o
140 160

Pour insertion du titre, des fréquences, titres des axes, utiliser ’'option DESIGN
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Ll |EE

|Add Chart§ Quick

Change ™™= ....

B v

File Home Insert Pagelayout Formulas Data Review View Help | Chart Design | Format

= e == |
Rl =l T E g
AT S |||l e ||| et g %5 i Switch Row/ Select Change

=

Element ¥ fayout v | Colors > L Column Data Chart Type C
Chart Styles Data Type Lo
I Axes be
“E Axis Titles > fe
B ChartTite >
= B € E G H I J K L
(i Datalabels bl e I | i
psitif BH 84 34
Data Table ositi BN 7 7
Iy > ositif
sgatif (5] 147 67
8 ErrorBars b4 g.a.l
' ositif MM 2 5
| Gridlines Dsiti SM 32 15
m 3 i
Lo\ =gatif
L d >
| B Legen Ssitif o o c
7 psitif Repartition des patietns par rapport aux Comte et COVID-19
{ - 2gatif
2 Trendline > ga!
{ agatif 15
L0 > 2gatif v | —
25 (L) positif
29 |BH negatif M r 5
30 | negatif 2
31| positif o
32 o cosel ] E o | — 17
33 | positif fe) S
34 |BH negatif 7
35 negatif BN . 7
36 |C) negatif
37 |BN positif BH _ 34 o

0 ! nous sélectionnerons toute la base de données (dans notre cas, les deux

variables Tabagisme et Sexe)

0 Dans 'option HOME on va chercher 'option Sort & Filter-> Custom Sort-> Type du

traitement

> AutoSum ~| A
il ~ Z?

1 Comme

O @

Sort & § Find & Analyz

©cear~  lriter vfelectv | Data
Editi 2] sotatoz |5
gl SortZto A
Custom Sort...
ecmneer | Y fiter
2nsitive sorts. \—,v
| TL=
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Sort ? *
+5dd Level 3 Delete Level [\Egopy Level Options... My data has headers
Caolumn Sort On Order
Sort by Sexe i | cell values v | |AtoZ s

oK Cancel

0 Pour remplir le table de contingence cree entre les deux variables

E . F G H .
Hypertension=oui Hypertension=non Total
Feminin 128 57
Masculin 152 63
total

o0 Utiliser la fonction COUNTIF: voir I'image ci-dessous

! E F G ! H ! ! J ! K ! L !
Hypertension=oui Hypertension=non

Feminin |=COUNTIF(B2:B186,B3)
Masculin

Function Arguments ? X

COUMNTIF
Range B2:B18& b = {"non""oui";"oui";"non";"oui";"non";"non";"oui";"no
Criteria | B3 * = ou
= 128

Counts the number of cells within a range that meet the given condition.

Criteria is the condition in the form of a number, expression, or text that defines which cells will be
counted.

Formula result = 128

Help on this function Cancel

l1|Page



Informatique Médicale & Biostatistique

Ou Range = les cellules de la colonne Hypertension qui correspond aux femmes

Criteria = une cellule contenant la catégorie « oui » de la variable nommée

Hypertension

* Tableau de contingence va avoir la forme finale suivante :

E F G H |
Hypertension=oui Hypertension=non Total

Feminin 128 57 185

Masculin 152 63 215

total 280 120 400

0 Clic droit sur le graphique.

0 On choit I'option Select Data (fr. Sélectionnez les données)

0 L’option Switch Row/column (fr. Changer Ligne/colonne)

£ | 6 | v | 1 | 0 | ¥k | i | w™m | N | o | e | [«
Format Shape
A e
O O
b Em
Select Data Source ? X
Chart data range: | =SheetdiSAS:6C83] S
Chart Title —
| — [ suitch Row/column | |~ |
25 J £ S—— 4
Legend Entries (Series) Horizontal (Category) Axis Labels
20 1 add FZEdt | D Remove |« | w [ edit
5 Incisive latérale gauche FEO groupe
Incisive latérale droite ID groupe
10
5
0 Hidden and Empty Cells cancel

FEO groupe

1D groupi

W incisive latérale gauche  mIndisive latérale droite “
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